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Web technologies on Tizen



Web technologies on Tizen

* Tizen utilizes web technologies for application compatibility

HTML5 CSS3
JavaScript

In-Vehicle-Infotainment
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Supported web APIs

* Tizen follows many standard W3C APIs and provides a
powerful set of device specific APIs

( Tizen specific Device API \

Alarm Contact  FileSystem

Bluetooth Application  LBS Geocoder

Time  Power (alendar  Messaging

Qedia Content NFC  System Informaw

-

Button

Color

Pop-up

Qage Slider  Control bar Multimedia Viey

Web Ul framework \

Check Box List

Context Pop-up  Option Header

Header & Footer Handler

/ W3C API

\_

\ fSuppIementary API \

/
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Component of Tizen SDK 2.0.0 Alpha



Tizen SDK
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 Consists of

IDE

Web Simulator
Emulator

Event Injector

Ul Builder
Documents

Sample applications
Remote Inspector
Localization Wizard

Project Wizard




IDE

8/39

Eclipse + additional plug-ins

]
ok
R

@ Tizen Web - Tizen IDE E@
File Edit Mavigate Search Project Run Window Help
CH - ﬁ -3 - % =N A - - - - r='g ﬁ& Tizen Web
roject Explorer Cutline <, Event Injector

Project explorer

Editor area

Connection Explorer Proj alll E
Files
Connection Property/
problems Console | [ Pages HTML/
explorer Problems/..,. CSS Preview
Console/
Pages

An outline is not available.

Outline/
Event Injector

JX

w=mTOUNDATION



Web Simulator

* Can simulate Tizen Web App.

— Using Configuration Panel, simulates various aspect of device

Configuration panel

9/39

eb ato elloworld
file: /D fizeniHelloworldfindex html
* Resolution & Orientation

b Platform API

¥ System Summary

Helloworld ‘
Platform: TIZEN L) 2
Version: 1.0

Device: WYWGA (480x800)
Manufacturer: Generic
0S: Generic Generic
Screen: 420x800
Pixel Density: 96 PPI

Browser(s): Generic

Mozilla/s.0 (X11; U; Linux x86_64, en-US)
User Agent:  AppleWebKiti533 2 (KHTML, like Gecka)
Chrome/5.0.342 7 Safari/533.2

b Accelerometer

» Messaging

b Call

* Geolocation

b Time Zone

» Feature Configuration
b Device & Network Settings
b Sensors

b Battery

b Application

b NFC Adapter

¥ Power Manager

Tizen App

An empty template of Tizen

Home About Us Contact Us
»+ Application Name

This is an empty template of Tizen Web Application. Tizen will support
multiple device categories:

« smartphones, tablets and smart TVs
* netbooks, in-vehicle infotainment devices

This is a basic section of a document.

The following button displays a time using JavaScript.

ompany Name. All rights reserved




Emulator

e Emulator

— Using Emulator Manager, you can configure certain device characteristics
— You can test your application before deploying to physical device

e Connection Explorer

— Shows connected devices and emulators
— Can explore the file system of the device

[Z& Connection Explorer & =0
B EE

Files i
a [ emulator-26100 (Em1)

. 22 bin

. [ boot

[ csa

- [0 dev

. [0 etc

- (3 home

. 3 lib

. [0 lost+found -

- [0 media

. [ mnt

. [ opt

. £ proc

. [, root

. 77 run a2

T CILIN
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Event Injector

* Artificial events are generated

o= Outline [Ey Event Injector 53 =0
and transferred to emulator Telephony | sensor | Nfe ocation | DU
. « Batt
— Device e
|_ . Battery |
- ocation
Level : « [l * 100
- NFC Charger : @ Connect () Disconnect
— Sensor
- Earlack
— Telephony Earjack

3 Wire 4 Wire @ Disconnect

- USBE

Usb

) Connect @ Disconnect

b RSSI

» SD Card

4 1 | »

1 THIEN
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Ul Builder

* Ul layout code generation

* Easy programming model — Tizen Web Ul Builder Project

El ELLE (7] pagel page &2 Create a Web Application Project

% | 720X1280 - | = dp | Project name must be specified
q 53 Palette Single-Page Application [+]
= List Views * This i & singls pags ballerplate tamiplats that you 2an copy 1o biskd your first
Tizen ¥ieh Ul Framewark page. o
= = R = @»@
List View List Wiew Swipe Template Sample  User Template
Ttem List ,
a4 Tizen
— = Basic E Empty Project
_ LI * Tizen Web UL Framework
Cere jQuery Mobile E Single Page Project
=2 = m Tizen Web UI Builder
Button Segment  Segment
Control Control E Multi Page Project
- Item
E-oW  Mavigation Project
= HTML * : -
Ao, Hikz o |
Form Heading Image
Control
[== Form Elements &
S ===
e v EEE
Checkb..  Checkbox Color
Item Palette
—" — i Project name:
= Toolbars
(= Content Use default location
Design_~~ Preview D:#tizen

1 THIEN
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Documents

 Documentation for development is provided
— Getting started with Tizen
— Programming guide & Tutorials
— API references
— Tizen platform programming

@ Help - Tizen IDE =N =R
Search: |injector Scope: All topics
Contents G- B ] P ¥+l & O
= B Tizen Web App Programming Tizen Web App Programming = =
= L Basics of Web App Programming . .
B Application Model Web Application Development Process

& (24 IDE and Tools The following figure illustrates the process of developing a Tizen Web application. Tizen provides the tools required to manage
El Tizen Web SDK Features your application’s life-cycle from product conception, through development and release, to end-of-life application retirement.

G web IDE
34 u1 Builder
¥ web Simulator

BReE Application Development Process
I Creating the Application Project
[ setting Widget Configuration Set preferences
[ Designing the Application UT and Implementil
4 Building a Widget
2 Running and Debugging Applications
4 packaging Applications
[ setting Preferences

i pregramming Guide

¥ Tutorials

[4 API References Package
£ sample Applications

Create the

project

Create the
application Ul

Help->Help Contents

13/39



Sample applications

* Speeds up the learning curve for a new developers
— 15 sample applications are provided to demonstrate the Tizen Web API

& new Tizen Web Project o |2 ]
Create a Web Application Project oy
Project name must be specified E
=]
%
Template SEIER ser Temnplate
Device API »,n Alarm
Type: JavaScript
sy ~Ppication | Atutorial sample application demonstrating the tizen alarm device
APl usage.
“Cl A o
'y Appsenvice

m

L]
» = Blustooth Client
F R

‘

» & Bluetooth Server
F R
“‘

Y Calendar

‘o
PR

Call e

4 | i | 3 -

Project name:

Use default location

Doizen

@j < Back Mext = Finish
TJLIN
14/39 L FOUNDATION




Hello world!



Creating a project

* Create a new project
& Tizen Web - Tizen IDE [E=NE=E °X7

Edit MNavigate Search Project Run Window Help

Mew Alt=Shift=N » | [} Tizen Web Project L - - &5 [ Tizen Web
Open File... F9  Project... = =

pen s =0 O || 5= outline 2 ™._E& Event Injector 8
Close Cirl+W | % Other.. Ctrl+N -

Close All Ctrl+Shift+W ‘

File -> New ->Tizen Web Project
e Select project template

& New Tizen Web Project

Create a Web Application Project
Create a Web Applicaticn project in the workspace or in an external location.

|—> Select project template

Project name] Helloworld|

> Write project name

Use default location

D:#tizenwHelloworld

THIEN
@:J < Back Mext > Finish ] [ Cancel
16/39 L] FOUNDATION



Files in project

* Files created using Blank template

L5 Project Explorer £3 = File Description
=2 Helloworld ) ) i ] i ] ]
m), JavaScript Resources config.xml General information about icon, license, width, height,
&= css and others
21 style.css _ _
= images index.html App starting page
B tizen_32.png . L
& s icon.png Application icon shown on menu
2 mainjs . . e
& WebContent main.js Main JavaScript file
A ganfia sl style.css CSS file to define consistent look and feel
[ icon.png
=1 index html

* Files created using Tizen Web Ul Builder template

(3 Project Explorer 22 E g File Description
4 2 Helloworld2
. ml JavaScript Resources page Set of files describes how to construct an individual
4 [ 055 page
21 style.css

4 i page app.xml Manages page hierarchy, page transition, event

> [ pagel.page handler binding

. [¥] page2 page
4= tizen-ui-builder-fw tizen-ui- Framework files that define page base-class and start-
> = tizen-web-ui-fw : _

& WebContent builder-fw up page

> 5 appxm| tizen-web-ui-  Tizen Web Ul Framework library

5] configxml

THE
8 conrs w CJLINUX
17/39 FOUNDATION




config.xml - Feature

* To use restricted APIs, declare features

5] configxml 2
® Features

Managing the Features

"feature’ element indicates what sensitive AFL or API groups this widget declares that it may attempt to access.

7

Owerview | Widget | Feature | Access | Localization Pref

.

& add feature

Add feature to 'Helloworld’
Add feature to the widget project

hitp://tizen_org/api/alarm
http://tizen.crg/api/alarm.read
http://tizen.org/api/alarm.write
http://tizen.org/api/application
hitp://tizen.org/api/application kill
http://tizen.crg/api/application.launch

httm- S tirnn nra Sani fammdicatinn rnad

i) Feature name:

(7 File:

]
[}
1

Einish

18/39
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config.xml - Access

* Declare the URL to access external network resources

&5 *configxml 53 = 0O
@® Access

Managing the Access

‘access’ element describes the permissions for accessing network resources.

Metwork URL Allow subdomain Add

Remove

Overview | Widget | Feature | Access | Localization | Preferences | Tizen | Source

1 THIEN
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config.xml - Preferences

* Persistently stored name-value pair that is associated with the
application the first time the application is initiated

¢4 *configxml 53 = 0O
£} Preferences

Managing the Preferences

'preference’ element are name value combination which can be set or retrieved through widget APL

Mame Value Read-only Add

Remaove

Cwerview | Widget | Feature | Access | Localization | Preferences | Tizen | Source

1 vl E
20/39 L FOIUmATION



config.xml - Tizen

* Setting for Tizen schema extension, like ID or appservice

¢4 *configxml 53 = 0O

«+ Tizen

Managing the Tizen

This section describes tizen specific information about this widget.
application
D XBXPZFXACY
Reguired version 1.0

setting
screen-orientation contextmenu

[] appservice

appservice

Sl

operation | httpy//tizen org/appcontrol/operation/default
scheme

mime

Cwerview | Widget | Feature | Access | Localization | Preferences | Tizen | Source

1 THIEN
21/39 L FOUNDATION



Creating Emulator

22/39

* Using Emulator Manager, you can create an emulator

— Click & button in Connection Explorer

P

I Emulator Manager
e 2
Mame

4 tizen20
4 ¥86-standard

<< Create new... =

eml
4 Custom
<« Create new... ==

CPU  Resolution

x86

Density  RAM size

720 x 1280 316 512

(o] & |wes]

Cretail

Mame

Base Image

Display Resolution
Display Density
RAM Size

File Sharing

File Sharing Path
HW Virtualization
HW GL Acceleration

Max Touch Point

emulimg-2.0.x86
HD{720:1280)
316

512

Mot supported

[ Mone )
Supported
Supported

o

4

I

’ g Cregte

aunch




Creating Emulator

* Using Emulator Manager, you can create an emulator

— Click & button in Connection Explorer

B Emulator Manager =N e
e 2
Mame CFU  Resolution Density RAM size | Create
tizen2.0 Name em2|

xB6-standard
<< Create new... ==

eml %86 720 x 1280 316 a1z Base Image emulimg-2.0.x86
Custom Display Resolution ’HD(?EDxlEED] v]
<= Create new... = >
Display Density 316 =
RAM Size 512 mB q
File Sharing ’Nn:rt supported v]
File Sharing Path [ Mone
HW Virtualization | Supported -
HW GL Acceleration |Supported  ~|

Max Touch Point 2

‘ m b 3 Cancel ” @ Confirm ]

CILIN
23/39 FOUNDATION




Creating Emulator

24/39

* Using Emulator Manager, you can create an emulator

— Click & button in Connection Explorer

[

I Emulator Manager
0 2
Mame
tizen2.0
xB6-standard
<< Create new... ==
eml
em2

Custom
<< Create new.. ==

CPU  Resolution

x86
X806

720 x 1280 316
720 x 1280 316

4y Reset == Delete Clone [ Create Base Image

Density  RAM size

512
512

4

I

(o] & |wes]

Cretail

Mame

Base Image
Display Resolution
Display Density
RAM Size

File Sharing

File Sharing Path
HW Virtualizaticn
HW GL Acceleration
Max Touch Point

em2
emulimg-2.0.x86
HDN720:1280)
316

512

Mot supported

[ NMone )
Supported
Supported

3

EF Modify




Running apps on emulator

g BB il O 7:160m

izen App

An emply template of Tizen

About Us Contact Us
il 1| L=l

& Tizen Web - Tizen IDE ».: Application Name

File Edit MNavigate Search Project Window Help B e el of Tucen Weo bplicaion.

L

= | = ﬁ = i} Resume - * smartphones, tablets and smart TVs
+ netbooks, in-vehicle infotainment devices

.|

Suspend

LD Project E):plﬂrer o = l his is a basic section of a document.
Terminata

= | SLLLLLELS he following button displays a time using

H=le Step Into

4 72 Helloworld

Step Ower
- = JavaScript Resources . .
} ‘Ejl e EtE: H_Etl_lln 2012 Company Name. All rights reserved.
» = Images Run to Line
q=3 T Use Step Filters Shift+F5
4 = locales
= en @, Run Ctrl+F11
> 5= ko *, Debug F11
= WebContent _
H cc—n"ig.:::rnl Bun Histony | 2
—— — Run As v |Bg 1 Tizen Web Application
3 Connection Explorer &2 RUN ConTigurations... TZen WeD Simulator Apphicaton

Run -> Run As ->Tizen Web Application

1 THiEN
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Localization

izen App

An empty template of Tizen

About Us Contact Us

+'3 Application Name

his is an empty template of Tizen Web Application.

izen will support multiple device categories:

* smartphones, tablets and smart TVs
* netbooks, in-vehicle infotainment devices

his is a basic section of a document.

he following button displays a time using

112 Company Name. All rights reserved.

izen App

Tizen Bl HE&!

wi OjE2|FH0|M OB

his is an empty template of Tizen Web
fpplication. Tizen will support multiple
device categories:

* smartphones, tablets and smart TVs
* nethooks, in-vehicle infotainment
devices

his is a basic section of a document.

he following button displays a time using

© 2012 Company Name. All rights reserved.

Project -> Localization -> Localization Wizard

26/39



Localization wizard

* Select files for localization

’ @ Localization Wizard o[BS

Select files for localization

The Localization Wizard will guide you through the process of widget localization.

Select the files below, that you want to localize.

Info

Already localized files are displayed as grayed.

1= alarm.html -
] £ application.html L
[] = calendar.html

[ = call.html

[C] |2l contact.html
[ £ css/demo.css

[ 5] css/images/ajax-loader. png
[ 5 css/images/icons-18-black.png
[ |5 css/images/icons-18-white png

Deselect All

¢_| 11} b

Click Mext = to continue.

@:‘ <Back |} Next> | [ Finish l ’ Cancel ]

1 THIEN
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Localization wizard

 Select the locales

-

o [ S|

@ Localization Wizard

Select the locales
This Lecalization Wizard page will enable you to select the locales for which widget should be internaticnalized.

Select the locales that will be supported by the widget.

Info
Already supported locales are displayed as grayed inside the "Selected locales” window.

Filter
ID (* = any string, ? = any character):

Available locales: =~ Selected locales:

@ Japanese [ja ] i @ English [ en ]
@ Spanish [ es] ’ Add --> l @ Korean [ ko ]

~|| Addal-—> | _

E

Click Mext = to continue.

Finish l ’ Cancel ]

@:‘ < Back “ Next> | [

28/39



Localization wizard

* Associate files with specific locales
’ & Localization Wizard Lo ==

Associate files with specific locales

This Localization Wizard page will enable you to localize previously selected files for chosen languages

Localize files for available languages

Info
- unchecked checkbox indicates that the file won't be localized for appropriate language

- checked checkbox indicates that the file will be localized for appropriate language
- grayed checkbox indicates that the file has been already localized for appropriate language

English [en] Korean [ko]
alarm.html v ]
application.html vl v
calendar. html ] v
4 L I

@:‘ Mext = Finish l ’ Cancel ]

iF]

29/39



Localization

* Update the files on locales folder

|:| [a|ec orer main.|s | m
%5 Project Bxplorer 53 = 5)([ mainj index html 52
E {;:-b | 2 =i <IDOCTYPE html:
% Helloworld g =
T2 Hellowor o = <head>

=\ JavaScript Resources

<meta charset="utf-8" />

= 58 <meta name="viewport" content="width=device-width, initi
= images <meta name="description” content="Tizen basic template g
ic = .
= | <title>Tizen Web IDE - Tizen - Tizen 718 KS2AN&</titles
= locales
= en <link rel="stylesheet" type="text/css" href="css/style.c
= ko s <script src="js/main.js"></script>
= css </head>
images
= : ] = <body>
= Js = |headers]
% icon.png = <hgroupz
&1 indesxhtml <hl1>Tizen App</hl>
= WebContent <h2>Tizen & @2x</h2>
=) P’ | - /heroup>

30/39



4

Debugging apps



Writing code

* “Contents Assist” suggests available functions and keywords
e “Jlint” automatically shows the syntax errors and warnings

- =z e W I

var h = today.getHours();

var m = today.getMinutes();
var s = today.getSeconds();
m = checkTime(m};
s = checkTime(s);
document.
document. X
£ - set1y 2 a@nchers  HTMLCollection
& gpplets  HTMLCellection -
console.l & atfributes  MamedModei
& body HTMLElement - HT
& childModes  ModeList - N
ams | B Cont u constructor  Function - O
mnExplorer & cockis  String - HTMLDo!
& defaultvView Window - D
4 doctype  DocumentType
& documentElernent  HTML
& domain  String - HTMLDY
4 firstChild  Mode - Node
Press "Ctrl+Spi
32/39

Zl *mainjs 52

= function startTime(){

var today = new Date();

var h = today.getHours();
var m = today.getMinutes();
var s = today.getSeconds();

m = checkTime(m);
5 = checkTime(s);

document.getElementById( 'divbuttenl').innerHTML="Current time: "

t = setTimecut(startTime, 258);

h

= function checkTime(i}) {
if (i < 18) {
i="e" + 1i;

return i;
Multiple markers at this line
- Syntax error, insert "else BlockStatement” to complete BlockStatements
- Missing semicolon
) prl— Syntax error, insert "}" to complete MethodBody

Press 'F2' for focus

= 0O

+h + "4

m




Log messages

* Display messages in console view
— console.log("console.log");
— console.info("console.info");
— console.warn("console.warn");
— console.error("console.error");

— console.debug("console.debug");
# b

// window.onload can work without <body onload="">
window.onleoad = init;

© G i B |

izen App

An empty template of Tizen

= function startTime(){
var today = new Date();
var h = today.getHours();

Home About Us Contact Us
var m = today.getMinutes();

var s = today.getSeconds();

m = checkTime(m);

5 = checkTime(s);

document.getElementById( "divbuttonl').innerHTML="Current time: " + h + ":" + m + ":" + s;
t = setTimecut(startTime, 258);

+ 5 Application Name

his is an empty template of Tizen We
izen will support multiple device cat

conscle.log("Current time: " + h + ":" +m + ":" + 5);
; * smartphones, tablets and smart
1 * netbooks, in-vehicle infotainme
* problems | Bl console 32 Pages | 53 Progress ENN IR =R

: his is a basic section of a document.
avascript log console (emulator-26100)

arc = 2, optind = 1 ,Kb @, rotate 4
————————— beginning of /dev/log_system
————————— beginning of /dev/log main
js/main.js (29) :SyntaxError: Expected token '}’
js/main.js (5) :init() called

2

he following button displays a time
avaScript.

Current time: 14:23:45

js/main.js (12) :Current time: 14:23:41

js/main.js (12) :Current time: 14:23:41 L .

js/main.js (12) :Current time: 14:23:41 2012 Company Name. All rights re
js/main.js (12) :Current time: 14:23:42 TH
js/main.js (12)

E
:Current time: 14:23:42 IN
U

33/39 et O



Remote Inspector

 Remote Inspector supports JavaScript debugging with

Emulator
Elmain.js

|3 Remote Inspector - Helloworld &3

Sources | Content scripts

v |:| optiappsixBXPZFXACS/res/wot/ces
style.cas

A I:I optiappsixBXPZFXACSres/wotljs

H > o v 0 O

[y

s W R WY Ry A ]

(=]

w

main.js
var startTime;
var checkTime;

f/Initialize function
var init = function () {
JF§ TODO:: Do your initialization job
console.log("init() called");
1
ff window.onload can work without <body onload="">
window.onload = init;

function startTime() {
var today = new Date();
var h = today.getHours();

var m = today.getMinutes();
var s = today.getSeconds();
m = checkTime(m);
s = checkTime(s);

document.getElementById( 'divbuttonl').innerHTHML="Current time:

t = setTimeout(startTime, 258);
K

function checkTime(i) {
if (i <« 18) {
i=II8II + i;
T

return 1i;

4 1]

+

h

+

n v
» Watch Expressions + C
¥ Call Stack

MNot Psuzed
¥ Scope Variables
Mot Psuzed
¥ Breakpoints
No Breskpoints

» Workers [ Debug

Run ->Debug As -> Tizen Web Application

34/39



Breakpoint & Watch Expression

 Opening aJavaScript File

El mainjs \# Remote Inspector - Helloworld 23

oo Qe S Skl

=1 main js () Remote Inspector - Helloworld &2

Sources | Content scripts |E| main.js

¥ optiappsixBXPZFXACIres/woticss 1 var startTime;
2 lvar checkTime;
style.cas

3
"'I:l optiappsixBXPZFXACS res/wolis 4| f/Initialize Ful

B mainjs 5 |var init = func

 Adding a breakpoint
— Right Click on Line number -> select “Add Breakpoint”

L1 Vvar s = Today.geTheconasy )
18 m = checkTime{m);

19 s = checkTime(s);

28 document.getElementById( 'divbuttonl').innert
23 e e e e B e e e ﬂ-qa}i

2] i

| Add Breakpoint

i .

3t eakpoint. ..

267 I="g + 1;

* Adding a watch expressions
Q =

=
0| u t e :I
¥ Watch Expressions + |C
| |

=
=]
¥ Call Stack =B 1 THIEN
35/39 L FOUNDATION




Summary



Summary

* Tizen SDK supports various tools for Web app development

1 THIEN
37/39 L FOUNDATION



Tizen information & support

b Search this site L

TIZEN TIZEN . oeveiopers

Log in | Register

My account | Log out

About Blogs Community Developers Source Devices Conference Home Documentation SDK Resources Forums

Home

The Tizen 2,0 Alpha SDK is now available. There have been significant improvements and additional features for Web applications, and even platform
developers. We encotrage developers to start working with these new features and functionality to provide feedback that can be used to improve

Tizen 2.0 Alpha SDK and Source Code release Upcoming Events Tizen until 2.0 official release.

Submitted by tsg on 25 Sep, 2012

Further enhancements and improvements to Tizen and its development environment will continue as we work towards additional releases
Today, we are happy to announce that the Tizen 2.0 alpha source code and SDK are now available. We ;‘5 ':“_C;’;;ZE“;;’PNe 2201122
encourage developers to start working with these new features and functionality and provide feedback that can ov - oV Getting Started
etting Starte
be used to improve Tizen during the final stages of its development. You can visit the community page to learn

more about participating in the Tizen project Get the essential resources, guidelines, and tools needed to create Tizen applications
Tizen 2.0 alpha has additional features, tools, and other improvements, including:

« Enhanced web framework that provides better HTMLS/W3C ART support and more Tizen Davice APIs The Tizen SDK t j Getting Started
¢ Multi-process Webkit2-based Web Runtime which provides better security and reliability for Web
applications The Tizen SDK provides you with the essential tools and Learn the application development process with step-by-step
¢ Advanced HTMLS features such as video subtitles and captions, battery status AP, screen orientation TEEES DR (e T CEFLEITE T T e
API, <keygen> and <detailss, and more Download the Tizen SDK Developing your first Tizen application
o New Tizen Device APIs for file transfer, notifications, and power control
« Advanced IDE & SDK for Web application development
o Install manager support for snapshot-based network installation
» Enhanced support for OpenGL ES
« New Platform SDK that helps platform development based on OBS Tizen Source E Join the Tizen Community
%
More information on the release can be found here: hitps;//source tizen.org/release

Find all Tizen components and explore the Tizen source The Tizen community is made up of all the people who
We look forward ta getting feedback and making additional enhancements ta Tizen over the coming months C00e.  code ol ST T T T . @ il
There are additional companents that we plan to 3dd in the coming weeks, and we will continue to fix bugs and ¥

add additional features.

Main site : https://www.tizen.org Developer site : https://developer.tizen.org

TIZEN

TIZ E N Source

Home Documentation Release
iioivin

To get an account, please register on https:/iwww.tizen.org and

Dashboards + (R

A g an Usemame
use your account to log into JIRA. Please read our bug guidelines |
Source Code Available for Tizen 2.0 Alpha 1 for more details.
Password
The source code for the Tizen 2.0 Alpha has been released, This release is targetad towards smartphones and runs on the PC emulator and an ARM- For account password reset, please go to link: =
based reference device. This release allows OEMs to begin considering Tizen 2.0 for their commercial devices, and open source developers to look into y . :
Tizen to find what they can improve and contribute. nitps:iiwww.tizen.orgluser/password
Tizen provides a standards-based software platform for multiple device categories, which supports Web applications. The API reference provides a Remember my login on this computer
comprehensive description for application development. Activity Stream Not a member? To request an account, please contact your JIRA
For information on how to obtain the source code and start platform development, visit our Developer Guide administrators.

Tizen Project

Getting Started

Login] Cant access your account?
Get the essential resources, guidelines, and tools needed ta create Tizen applications and download the source code

Wang Quanxian commented on TIVI-215 - Touch on VMC1000 with
11 needs workarou the finger r tally, but cursor moves

Tizen Source Code ﬂ Latest Snapshots verticall
Download the Tizen source code. Get the latest images, repos and kickstart files. tslib alsa not work
Source Code Download snapshets

-sh-4.1# cat S1-touchscreen.conf

Section “InputClase

Identifier TouchScreen

MatchPraduct "DIALOGUE INC Penhlount USE

Code Review Contribute to OS Development BT D
Option "SwapAxes” “on’
Review the latest Tizen code, Get started contributing to Tizen it 3 #Qotion “Calibration” 100 899 269 509 =

Source site: https://source.tizen.org Issue-tracking site: https://buqs.tizgnéorq

LINUX

FOUNDATION



https://www.tizen.org/
https://developer.tizen.org/
https://source.tizen.org/
https://bugs.tizen.org/

Thank you!



